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Using Wraptures
This document provides information on how to use Wraptures in various 
applications.
See the document “Wraptures Manual” for information on how to use the Wraptures
CD-ROM and the Browser.
____________________________________________________________________________

This document contains the following sections:

• “Using Wraptures For Tiling” -- gives basic information and instructions on how to 
use Wraptures as tiles and fill patterns to create large backgrounds and high 
resolution files for printing.
• “Using Wraptures to Wrap around a 3D Object” -- gives basic information and 
instructions on how to use Wraptures as texture maps in 3D applications.
• “Using Wraptures as Backgrounds and in Printing”  -- gives basic information and 
instructions on how to use the 640x480 size of the Wraptures as presentation 
backgrounds and explains  how to use Wraptures in printing.

____________________________________________________________________________

Using Wraptures
Overview  
Wraptures textures are seamless, tile-able  PICT files.  This means that a Wrapture 
can be placed next to a copy of itself and no seam can be detected.  Wraptures can
be used in ways that take advantage of this seamless property as well as be used 
like any standard non-seamless pict file.

There are two basic ways to use Wrapture textures to take advantage of this 
seamless property:   to fill an area (Tiling), or to wrap around a 3D object 
(mapping), hence the name "Wraptures".  Tiling allows you to cover an area as 
large as desired with a Wrapture.  This is useful for creating high resolution images 
for printing, for creating very large size backgrounds, or for reducing the amount of 
RAM used by a background when using an auto-tiling option available in some 
programs.  Mapping allows you to wrap a Wrapture around a 3D object and have 
the ends of the texture meet seamlessly.  This is useful for 3D stills and animations.

Since Wraptures are standard Apple PICT files, they can be used in any program 
that imports PICT files or allows the pasting of graphics from the clipboard.  Each 



Wrapture texture also comes in a non-tileable full screen (640 x 480) background 
size to use in presentations.  

This disc also contains a few WraptureReels which are seamlessly looping video 
clips and animations in QuickTime file format.  WraptureReels can be used as 
environment maps in 3D applications or used like standard QT movies:  in 
presentations, animations, and HyperCard stacks.  If you enjoy the WraptureReels 
on this disc, we have a whole CD-ROM full of them called WraptureReels One.  The 
Reels disc contains 25 Seamlessly Looping, Broadcast Quality (640x480 at 30 
frames/second) JPEG compressed QuickTime movies that can be used as described 
above as well as be used to put out to video tape (post Premier QT editing and fun) 
with excellent results .  The disc also contains 18 presentation backgrounds and 
many sound effects.  

Wraptures Usage rights and Copyright:  
The content on the Wrapture One CD-ROM is licensed, not sold, to you as the sole 
owner of this disc and can be used on only one computer.  You must purchase a site
license if this disc and /or its contents are to be used by more than one person.  All 
titles and copyrights for this disc and its contents remain with Form and Function.  
This license allows the REGISTERED user to use the contents of this disc in their 
own creations as part of a graphic piece for distribution, broadcast, or performance 
wherein the creation does not use any of this disc’s contents or derivatives as the 
primary source of the creations value. The contents of this disc or its derivatives 
may not be offered for hire, or duplicated and/or manipulated for resale or 
redistribution in the form of a collection or library (such as a media library, 
reproduction art, or stock design). You MUST send in your registration card to be 
considered a registered user.  Form and Function and the reseller of this disc are 
not liable for any damage or loss, arising from the use of this disc and its contents. 
This license can be revoked at any time.  Contact Form and Function if you have 
questions (415) 664- 4010.

Using Wraptures for Tiling 
What are Tiles:  in computer graphics terms, a tile is a graphic that can be laid end 
to end and/or side to side, with no visible seams.  Wraptures are tiles.  This 
optimization is extremely versatile for a number of graphical applications.
Tiling:  Tiling is the act of placing tiles end to end and side to side to cover an area. 
By tiling you can create large backgrounds, and large, high resolution images for 
printing.
Tiling Methods:  There are two tiling methods, "Manual" and "Automatic" 
The Manual Method: By pasting and positioning end-to-end a copied tile numerous 
times you can tile, or fill, an area.  This method can be used in any graphics, 
multimedia, or  presentation application or any other application that has standard 
paint tools.  Following are general instructions on how to do this.   Be aware that 
individual programs may use different key combinations to constrain and duplicate 
a selected item.  Consult the manual for the graphics application you are using for 



specifics on key combinations.
1.  “Import” or “Open” the graphic.  Many applications have an Import or Open 

option under the “File” Menu.  You may need to use the clipboard to bring a 
Wrapture into an application.

2.  Select the graphic imported using the selection marquee or “Select All” under 
the “Edit” menu.

3.  Select "Copy" from the “Edit” menu or command-c
4.  Select “Paste” from the “Edit” menu or command-v
5.   Constrain and move the pasted tile.  With the shift-key held down hold the 

mouse down on the newly pasted tile and slide the tile either horizontally or 
vertically towards the new tile location.  Line up the end of the new tile with 
the adjacent end of the original.  

6.  To complete filling an area repeat the process:  paste, then with Shift-key down, 
move the new tile to the next location.

7.  Some programs allow you to copy and constrain a graphic object by holding 
down the Shift and Option keys.  This means that all you have to do is hold 
down the keys, hold the mouse down over the selected tile you want to copy, 
and then slide the mouse in the direction of the location for the new tile.

       
The Automatic Method: Some applications have automatic tiling functions that 
allow you to import the tile and then specify it as a tile or fill pattern within the 
program.  This has the added benefit of reducing the memory size of the tiled area, 
since the tiling is programmed rather than  bit mapped.  MacroMedia Director, and 
PhotoShop are a few applications that have an auto tiling or a custom pattern fill 
ability.  One problem with automatic tiling is the size limitations certain programs 
place on tiles.  If the Wrapture you are using is larger than the size limit, then the 
Wrapture is going to be clipped so that it is no longer seamless.  This problem can 
be solved by using a smaller Wrapture that is within the tile size limit for your 
application.  See the index in the manual for the  application you are using for 
specific information on auto-tiling and fill patterns.  

Tile Size and Pattern Repetition:  Although Wraptures tile seamlessly, some 
repetition can be seen when tiling an area.  The repetition is more pronounced in 
Wraptures that have a centrally located object or an irregular texture.  By using a 
larger size tile to tile an area you can reduce the appearance of repetition, since it 
will take fewer repetitions of the tile to fill  the area.  When using an automatic 
tiling function in a program, using a larger tile will increase the size of the file since 
the larger tile is has a larger file size.  Also as stated above under Tiling Methods, 
some auto tiling functions have a size limit.  This means that you may have to go to
manual tiling to reduce pattern repetition.

Using Wraptures to Wrap around a 3d object 
The following are general guidelines and instructions for using Wraptures in 3D 
programs.  Please see the manual for the 3D program you are using for specific 



information on the following topics.
What is a Picture Map:  in 3-Dimensional application terms, a map is a picture that 
can be wrapped around an object.  Many 3D applications use four different types of 
maps:  bump maps, color maps, reflectance maps, and transparency maps. The 
four maps can be used alone or together to produce a variety of effects.  Wraptures
can be used as all four of the following  map types.
Bump maps:  these are usually gray scale pictures that the 3d program interprets 
as a relief map.  The darkest areas are interpreted as the deepest area of the map, 
whereas white areas of the map are the highest areas.  When a bump map is 
wrapped around the object (mapped) and rendered the object appears bumpy 
because of the map.  
Color maps:  these are pictures that are used by the 3D program to place a picture 
or a pattern onto a 3D object.
Reflectance maps:  these are images that are used by the 3-D program to project 
an image onto an object such that it appears to be reflected from another object. 
Environmental scenes of sunsets, clouds and other items are easily applied to a 
scene in this way for added realism.
Transparency maps:  these are images that define the degree of opacity an object 
will retain over a given area.

Mapping 
Mapping is the act of wrapping a  map around a 3d object.  As stated above you 
can use all the above maps for mapping.  Some three-dimensional applications 
allow you to specify how you want to wrap a map.  For example if you have a cube 
you could wrap the map around the cube spherically, or you could place the map 
on each side of the cube.   Since the mapping style may result the sides of a map 
joining or in a map being adjacent to a copy of itself , it is important to have 
seamless maps. Seamless maps also make the surface of the object appear smooth
and continuous.
Additional effects can be obtained through adjusting different attributes of the 
objects texture.  Glossiness (specularity), opacity,  and light refraction (diffusion, or 
contrast) are  attributes that you can modify for a map and are available in most 3D
applications.
Mapping Method:  The following is a general outline on  how to map a Wrapture to 
an object in a 3D program.  Refer to the manual for your 3D program for  specific 
instructions.
1.   Have an object ready for mapping, or use the tools provided to create a 3D 

object.
2.   “Import”  the Wrapture you want to use as a map.  The term “import” is used 

loosely considering the variety of methods used across applications to bring 
in a texture as a map.

3.  Adjust the attributes for the new texture map.
4.  Assign the new map created to  the 3D object.
5.  Adjust the lighting to suit taste.
6.  Render the object.



7.  Display it to admiring friends. 
Mapping Tips
Resolution: Wraptures are provided in a variety of resolutions.  These resolutions 
allow the user to choose the Wrapture best suited to the variety of criteria 
encompassed in a 3D scene.  These criteria can include memory constraints, 
computing horsepower, application- specific color optimization, and time.  For 
example, by choosing a low resolution version of a Wrapture you reduce the 
memory requirements, and rendering time, but lose image quality.  By choosing a 
high resolution Wrapture the image quality is higher, but you will need a faster 
computer and more memory to do the same task.  

Optimizing the use of your Wraptures via Resolution:  
You can optimize the use of your Wraptures by matching the Wrapture resolution to 
the proximity of the camera.  For long views of an object, choose a smaller version 
of the Wrapture since the camera is farther away and detail is not as crucial.  For 
close-ups and flybys, choose a larger version of the Wrapture since the camera is 
close-up and detail is important.

Using Wraptures as Backgrounds and in Printing
What are the Backgrounds? 
Backgrounds are pictures that are intended to be used as backdrops for other 
artwork and text. They are useful when creating  presentations or multimedia 
productions.  
Each Wrapture comes in a  non-tileable 640x480 background size.  The 
backgrounds, like the other Wrapture sizes, come in 32-bit and/or  8-bit (Apple 
Colors) color depths.  They are designed specifically for display on a 13” monitor.  
You can also create a larger size background with the tileable sizes of a Wrapture 
by following the instructions above on “Using Wraptures for Tiling”. 
Placing the Background:
See the manual for the program you are using for specifics on placing backgrounds.
1.  Import the background you want to use.   
2.  Position it on the screen to suit taste.
3.  Place other artwork and text on the background.

Using Wraptures to Print at any DPI (Dots Per Inch)
Wraptures are 72 DPI files.  Most printed material is between 150 DPI and 600 DPI.  
If you paste a 72 DPI Wrapture into a 150 DPI file, it will become smaller and not fill 
the area that it would in a 72 DPI file.  Therefore, in order to use Wraptures in 
printed material either 1) tile the area with the Wrapture, or 2) resample the 
Wrapture to a higher DPI .
Tiling to fill a Higher DPI Area: 
Since Wraptures tile seamlessly, you can use them to fill an infinitely large and/or 
dense area.  By using the largest tile-able size of the Wrapture available, which will 
be either 1024x512 or 512x512, you can reduce the amount of tiling needed to fill 



an area.  For information on how to tile an area, see the section above, “Using 
Wraptures for Tiling”.

Resampling Wraptures to a Higher DPI: 
Resampling is the process of increasing the DPI of a bit-map.  For a 72 DPI image to
be resampled to 600 DPI means that for each dot in the 72 DPI image there are 8 
(600/72) dots in the 600 DPI image.  Since this can cause the image to look chunky,
programs such as Adobe's PhotoShop further process the image on resampling with
blurring and other effects to minimize the chunkiness.  Because of this extra 
processing, resampling is better than stretching the image.  Future versions of 
Wrapture textures will address this situation by providing higher resolution scans.
Combining Tiling and Resampling:
By first tiling Wraptures and then resampling the tiled area to a higher DPI you can 
maximize the benefits of both of these methods.
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